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All rights are reserved.
Technical ones are subject to change.

An liability for the correctness of the contents of this publication cannot be taken over.
In spite of careful processing and programming a defect and/or complete failure of the 
WIBE can not be completely excluded. Due to atmospheric disturbances or to 
disturbances of other electrical and electronic devices, contents of messages can be 
falsified. The operators of the transmitting plants can change or stop the broadcasting 
service (temporarily or permanent).
Therefore no liability for availability and correctness of the indicated messages are taken 
over. In particular no liability for possible damages resulting from use of the WIBE and 
information of this manual will be taken over.
In this manual trademark, trade-names, customer-names, etc. are used.  Even if these are 
not particularly characterized, the appropriate protection regulations are effective. 

Note:
Software updates for this product are available in the Internet: 
http://www.wetterinfobox.com/english/Downloads.htm

2

http://www.wetterinfobox.com/english/Downloads.htm


Table of contents 

Scope of delivery....................................................................................................................3
Introduction.............................................................................................................................4
Connections...........................................................................................................................4
SD card interface...................................................................................................................5
Software.................................................................................................................................6

USB driver installation.......................................................................................................6
Software installation...........................................................................................................6
Broadcasting schedule......................................................................................................6
Reception test....................................................................................................................8
Weather Messages............................................................................................................9
NAVTEX Messages...........................................................................................................9
Barograph........................................................................................................................11
Synop data.......................................................................................................................12
Weather fax maps............................................................................................................13
Status-line........................................................................................................................14
Export messages.............................................................................................................14
Functional overview.........................................................................................................14

Operating instructions..........................................................................................................15
Environment.....................................................................................................................15
Internal clock....................................................................................................................15
Hints to radio reception....................................................................................................15

Specifications.......................................................................................................................16
Warranty...............................................................................................................................16

Scope of delivery

The following parts belong to the delivery scope of the WIBE:
• 1 x WIBE,
• 1 x USB-cable,
• CD with WIBE-software and USB-driver,
• User Manual.

3



Introduction

The WIBE is a receiver for weather-, fax- and NAVTEX messages for PC and notebook. 
Additionally the device contains an air pressure sensor to record the air pressure course 
for an interval of maximal seven days. The device receives weather messages PC-
independent. The WIBE stores all received data in the internal flash memory.
The German Weather Service transmits sea weather reports, weather forecasts  and 
station messages in German and English language on one long wave and five short wave 
frequencies.
Beside the known plaintext sea weather reports the German Weather Service also 
transmits coded weather messages, the so-called Synop/Ship messages. The WIBE 
software can decode this messages and show them as wind arrows on a map.
The facsimile maps of the German Weather Service are emitted on three short wave 
frequencies. The weather charts contain e.g. air pressure-, swell- and wind forecasts. 
Starting with software version 1.1.x the WIBE can also receive facsimile maps of the Fleet 
Weather and Oceanographic Center, Northwood, England. Starting with software version 
1.3.x the WIBE is able to receive the facsimile maps (without satellite images) of the North 
American short wave stations Halifax, Bosten and New Orleans.
The WIBE can receive NAVTEX messages alternatively on 518 kHz (internationally in 
English) or 490 kHz (nationally, national language).
The device does not have any control elements. All functions will be activated by the PC. 
The received text messages can be saved PC-independent on a SD card (see section SD 
card interface, page 5). Then the data can be displayed on mobile devices with SD card 
interface and web browser.

Connections

The figure below shows the connection assignment of the WIBE:

The antenna socket (BNC) can be 
connected with an active antenna 
(12V) or a passive antenna (e.g., 
isolated backstay with passiv-
balun).
If an active antenna is used, it 
should be mounted very high (best 
of all in the mast's top).
In the WIBE software you have to 
determine whether you use an 
active or passive antenna (see 
section Broadcasting schedule).
The antenna input has an 
impedance of 50Ω.
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Beside the SD-card-slot there is a light-emitting diode. The light-emitting diode turns on if 
the device is supplied with current.
For an easier connecting of the supply lines the supply terminal can be pulled out off the 
device. If possible, please connect line GND with the grounding bar of the ship or boot. 
With water contact the signal to noise ratio and therefore the reception of weak signals 
improves. The line GND is decoupled to the 12V(-) connection by an 100nF/50V capacitor 
in parallel with 100kΩ resistor.
When connecting the supply voltage please pay attention to the correct polarity. Protect 
the supply lines of the WIBE with time-lag 250mA fuse. The WIBE is protected internally 
with a resetable fuse element.
The WIBE can be integrated to the board connecting block. For receiving and saving 
messages in spite of the board network is switched off, the WIBE must be connected 
directly to the battery. Additionally the supply lines must be protected by a fuse directly at 
battery.
With the enclosed USB cable the connection of the WIBE (outlet USB) with PC/Notebook 
will be done.
The bulk of the USB jack as well as the connection 12V(-) are coupled with each other. 
Please note: you can get undesirable ground-loops between the USB connection and the 
PC. In such a case other electric devices can be parasetical connected with ground (or 
battery -). Devices needing much current could cause a damage in wiring or connected 
devices. 

SD card interface

The WIBE contains a SD card slot. So it is possible to save the received data on SD card. 
The WIBE saves on SD card only weather messages coming from German Weather 
Service (RTTY in german and english language) which are younger than 24 hours, as well 
as NAVTEX messages which are younger than two days. Fax and Synop data are not 
saved.
To save data on SD card, please insert a card in the card slot. The LED beside the card 
starts to blink. Please do not take out the card as long as the LED blinks. After some time 
the light-emitting diode turns off. Now the data are saved on the SD card and you can take 
the card out off the device.
The data on the SD card are saved in HTML format. Therefore, messages can be 
displayed on most mobile devices with SD card slot and HTML browser. With a Windows 
mobile PDA you have to do following steps:

● Put the SD card into the device,
● start the File-Explorer,
● open folder Storage Card,
● open at folder Storage Card folder WIBE,
● open file INDEX,
● follow the links in the file INDEX to see the specific message.

5



Please note that the WIBE can only handle SD cards which are FAT16 formatted. Most SD 
cards (memory size 32MB – 2GB) are FAT16 formatted. Do not use cards with important  
data on it (e.g. PDA navigation data). Mörer Schiffselektronik can not take over liability for  
lost data.

Software

You can handle the WIBE with comfortable Windows software. The software works with 
operating systems Windows 2000, XP, Vista and 7. The screen resolution should be min. 
1024x768 pixels. Software updates for the WIBE are distributed via the Internet. Look at 
http://www.wetterinfobox.com for getting news and updates.

USB driver installation

If the WIBE is connected to your PC for the first time, Windows asks for a device driver. 
The drivers are stored on the enclosed CD. Insert the CD in the CD or DVD drive of your 
PC. In most cases Windows finds the driver automatically. Follow the Windows installation 
instructions. If you have the possibility to choose a file directory for the driver, select the 
local CD/DVD drive. Please avoid an internet search for getting a suitable driver.

Software installation

The WIBE software is stored on the enclosed CD. In the folder Deutsch on the CD you will 
find the installation program for the German version. The folder English contains the 
appropriate installation program for the English version. For software installation start the 
wanted setup program (setup.exe). Follow the tips on the screen. After software and driver 
installation were successful the WIBE is able to work. Connect the device via USB cable to 
PC and start the WIBE program.

Broadcasting schedule

The WIBE receives all messages time controlled. The WIBE references the time from PC. 
Hence, it is important that the PC clock does not deviate around more than 30s from the 
current time. The local PC time is converted for the WIBE into UTC (Coordinated Universal 
Time).
To guarantee a correct conversion of the local time into UTC, time zone and summer and 
wintertime change-over must be adjusted the in Windows correctly. You can change the 
settings in Windows by clicking on the clock with the right mouse button (at bottom on the 
right on the screen) and select time/date. In this dialog box please adjust time and time 
zone correctly. The automatical summer and wintertime change-over must be activated.
The UTC is displayed in the status line of the WIBE program. So you can check whether 
the time settings are correct. Following commitments apply to the conversion CET / CEST 
(Central European Time / Central European Summer Time) in UTC:
UTC = CET - 1h,
UTC = CEST - 2h.
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For the configuration of the broadcasting schedule please select the menu
Settings->Configuration... or click on the suitable icon: . 

A configuration dialog for the broadcasting schedule is shown. In this dialog you can 
arrange your appropriate messages schedule.
The German Weather Service transmits german-speaking weather messages on one long 
wave and on two short wave frequencies. The english-speaking weather messages are 
emitted on three short wave frequencies. The weather-fax messages are likewise emitted 
on three short wave frequencies. The WIBE can receive the facsimile transmitter 
Northwood (UK) on three short wave frequencies. The transmitters in Halifax and Bosten 
can be received on four frequencies and the transmitter in New Orleans ca be received on 
three  frequencies.
The broadcasting schedule of seven different transmitters (DWD german/english/fax, 
Northwood fax, Halifax fax, Bosten fax, New Orleans fax) overlap. The messages which 
mutually overlap are locked in the broadcasting schedule. Thus it is ensured that all 
selected messages can be received.
If you click at the grey box of a locked message, you will be informed by which other 
message the schedule entry is blocked. For any message the reception frequency can be 
given. Click with the right mouse button on the suitable message in the schedule. A menu 
appears for frequency selection (see image on top). If you select AUTO the WIBE tries to 
find the best frequency automatically.
At the tab Summary in the broadcasting schedule an abstract of all messages to be 
received is displayed.
The satellite images from Halifax, Bosten and New Orleans will not be received by the 
WIBE. Messages which have no solid space in the sending plan will likewise not be 
received.
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If the top or the end of a fax message is permanently 
missing, it is possible to shift each broadcasting 
schedule some minutes forwards or backwards.
If the top of fax is missing, the picture is also often 
shifted sidewards, because then the synchronisation bar 
is absent at the top of the fax map (see picture on the 
left).

Shifting of the broadcasting schedule can be executed in the 
broadcasting schedule dialog on the ower right.
If the top of a fax message is missing, please shift the schedule 
some minutes forwards.
If the end of a fax message is missing, the start of the message 
recording must begin some minutes later.

During the free times in the broadcasting schedule NAVTEX messages can be received. 
You can select NAVTEX frequencies 490kHz or 518kHz. On frequency 490kHz national 
NAVTEX messages are emitted in national language. On frequency 518kHz international 
NAVTEX messages are emitted into English language. On tab NAVTEX it is shown which 
times are reserved for NAVTEX reception. If you activate the power save mode, no 
NAVTEX messages are recorded. In this state the WIBE is set into a power save mode 
during free times of broadcasting schedule. At this time current consumption of the WIBE 
is about 50-60mA.
If you handle the WIBE with active antenna, the active antenna must be enabled in the 
broadcasting schedule dialog. Otherwise the antenna is not supplied.

Reception test

The WIBE disposes of a reception test for the 
RTTY transmitter of the DWD. 
This function is reachable either via menu 
Settings->Reception test... or by a mouse click 
on the icon: .
As long as the reception test is active, no 
messages are recorded. The reception test 
window automatically closes after approx. three 
minutes.
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Weather Messages

To display weather messages please activate 
the tab WEATHER GERMAN or WEATHER 
ENGLISH. Click on a message type in the 
weather menu tree. The suitable message 
appears in the message window on the right 
page. The last three messages of every 
message type are saved.

New messages are displayed in the menu tree in bold font. Messages which were already 
displayed once are shown in normal font.

The complete menu tree can be opened with the button  and closed again with the 
button .  Additionally the reception date and time (UTC) is displayed for every message 
as well as the transmitter identification with appropriate frequency.
Please note that the WIBE software is delivered with demo-weather messages. Actual 
weather messages are only displayed, after they have been received. The transmission 
method (RTTY), the German Weather Service uses for transmission of messages, does 
not permit any error detection. Therefore errors can be contained in the indicated weather 
messages, which are not to be recognized as such.

NAVTEX Messages

In order to view NAVTEX- messages, please 
activate tab NAVTEX. NAVTEX menu tree is 
shown beside. NAVTEX messages are sorted 
according to their message type. For both 
NAVTEX frequencies (490 kHz and 518 kHz) an 
appropriate menu tree is available. The complete 
menu tree can be opened with 
button  and closed again with button . 
New messages are displayed in the menu tree in 

bold font. Messages which were already displayed once are shown in normal font.
Additionally the reception date and time (UTC) is displayed for every message as well as 
the message identification. NAVTEX messages received two days ago are automatically 
deleted, when the WIBE software imports new NAVTEX data from the WIBE.
The transmission method for NAVTEX messages (Sitor) permits a reduced recognition 
and correction of transfer errors. Characters, which were not received correctly, will be 
represented as underscore (_). Please pay attention: characters represented in a normal 
design could be incorrect, too.
The structure of a NAVTEX message is to be explained on base of following example:
ZCZC PA09
NETHERLANDS COASTGUARD
NAVIGATIONAL WARNING NR. 9 172128 UTC AUG
PLATFORM L10-G 53-29.4N 004-11.7E
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UNLIT
NNNN
A single NAVTEX message starts with the letters ZCZC, followed by the message 
identification (PA09). The first letter of the message identification indicates the master 
station. In this example it is NETHERLANDS COASTGUARD (P). In the second letter the 
type of message is coded (here navigational warning respectively navigation warnings). 
The next two numbers of the message identification (09) are a serial number. Number 00 
has a privileged position. It is reserved for distress messages.
NAVTEX messages have a time stamp. It is shown at the end of the third line (172128 
UTC August) and means: 17. August, 21:28 UTC. The time stamp refers to the date, the 
message was produced and not to the time of the radiant transmission. After these 
technical reports the message content follows. The message ends with NNNN.

The following table contains an overview of different message-types:

Code Message-type Menu option

A Navigational warnings Navigational warnings

B Meteorological warnings Meteorological warnings

C Ice reports Ice reports

D Search and rescue information Search and rescue information

E Meteorological forecasts Meteorological forecasts

F Pilot service messages Pilot service messages

G Information about DECCA navigation- system Electronic navaid messages

H Information about LORAN navigation- system Electronic navaid messages

J Information about GPS navigation-system Electronic navaid messages

K Information about other navigation-systems Other messages

L Additional navigational warnings 
(f. e. ring moves) Additional warnings

V Additional navigational warnings (f. e. ring list) Remaining messages

W Reserved for special service Remaining messages

X Reserved for special service Remaining messages

Y Reserved for special service Remaining messages

Z QRU (no messages) Remaining messages
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Barograph

The fourth tab contains the BAROGRAPH. The measuring 
data are represented in the diagram from left to right. I.e. the 
current measured value is located on the right side of the 
curve. The barograph has a measuring interval of one minute 
and resolution of 0,1hPa. 
The representation period can be decreased with the Zoom-In-
Button  and increased with the Zoom-Out-Button . The 
temporal gradation is 12h, 24h, 48h and 7 days.

You can increase a cut-out of the air pressure curve. Draw in 
addition a rectangular window with the mouse from above left 
to downward right. Use the left mouse button. If the mouse 
button is released, the appropriate range of the diagram will be 
shown increased. 
The enlargement can be cancelled again by drawing any 
rectangular window with the mouse in reverse direction (from 
downside right to upward left). 

The diagram is movable in any direction. Click in addition with the right mouse button into 
the air pressure curve and move the mouse. As long as you keep the mouse button 
pressed, the air pressure curve will follow the mouse movements.
The barograph data are only up to date, if a WIBE is attached to the computer. In this case 
the curve is represented in blue colour. If the air pressure data are not up to date (no 
WIBE attached), the curve will be represented in black. 
The WIBE indicates absolute air pressure. The shown value will not be converted to sea 
level. The air pressure will decrease by 1hPa per 8m. E.g. in a height of 80m above sea 
level the indicate pressure of WIBE is 10hPa lower than air pressure at sea level.

While the WIBE is attached to PC, the current air pressure and the air pressure tendency 
(calculated on three hours) are indicated on top of the screen. The air pressure trend is 
only displayed if at least the air pressure data of the past three hours exist.

Air pressure data ordinarily refer to sea level. However, the air 
pressure sensor in the WIBE measures the absolute air 
pressure. Is the location of the device above sea level you have 
to adjust the barometre height.
For this purpose open the configuration dialog (broadcasting 
schedule, menu Settings->Configuration ...).
On the right side of the configuration dialog you can adjust the 
barometre height (level above sea level). The WIBE software 
displays afterwards the air pressure referred to sea level.

Please note that all barograph data are deleted in the WIBE, if the device is switched off 
(is separated from power supply).
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Synop data

In addition to weather messages, the 
German Weather Service transmits 
encoded meteorological data of ships 
and fixed weather stations. The WIBE 
software decodes these data and 
indicates it in a map as wind arrows. 
Please activate the tab SYNOP for 
the representation of the Synop data. 
A pixel map is shown.

The red arrows in the map indicate Synop messages at the appropriate position. The white 
arrows indicate a weather station coming from reports of the German Weather Service for 
the North and Baltic Sea and the Mediterranean Sea.
Resting with the mouse pointer above an arrow, a reference display window appears and 
shows the radio call sign of the Synop message (or the station name coupled with German 
Weather Service station messages), the wind direction, the wind force as well as day and 
time of the message (UTC).
You can move the wind arrows map by clicking with the mouse in the map and moving the 
mouse. As long as you hold the mouse button the map follows the movements of the 
mouse.

To display all decoded 
information of a Synop message 
please click on the appropriate 
wind arrow (see page 10). A 
dialog opens with data in plain 
text format. If you click on a 
white arrow, the station 
messages of  North/Baltic Sea 
respectively Mediterranean Sea 
are indicated. The station 
belonging to the arrow is marked 
by a star (*) at the beginning of 
the line.

You can close the Synop 
Window with a click on the Close button or with a double-click into the text. The Synop 
data are also available in coded form on tab WEATHER GERMAN and WEATHER 
ENGLISH (in the menu tree below Synop). It is possible to store the data into a file, for 
instance to decode it with another program.
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Important note:
Transmission errors in the encoded Synop data cannot be recognized, since no check 
sum is present. Already small errors in the encoded data can cause absolute wrong results 
during decoding. So please pay attention of the data from the Synop messages and refer 
also to other sources of information for weather determination.

Weather fax maps

For displaying weather fax maps please activate tab FAX DWD, Fax Northwood, FAX 
Halifax, FAX Bosten oder Fax New Orleans. On the left side a menu tree is shown with 
received weather fax maps. For every message type, three weather fax maps are 
maximum saved. Additionally the reception date and time (UTC) is displayed for every 
message as well as the transmitter identification with appropriate frequency. New 
messages are displayed in the menu tree in bold font. Messages which were already 
displayed once are shown in normal font. The complete menu tree can be opened with the 
button  and closed again with the button . 

 

On the right side the weather fax map is displayed. You can move the fax map by clicking 
with the mouse in the map and move the mouse. As long as you hold a mouse button the 
map follows the movements of the mouse.
You can rotate the figure with the help of the icon  in 90° steps, to correct the figure 
position. This function can be executed also in the menu Settings->rotate. Via double click 
in the weather fax map the menu tree is hidden. The complete space in the WIBE window 
is available for the fax map. This action can be retracted by a new double click in the map.
With the icon  (zoom in) and the icon  (zoom out) you can change the scale of the 
weather fax map. These functions can be executed also in the menus Settings->Zoom in 
and Settings-> Zoom out.
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Status-line

The status line is located at the lower edge of the WIBE-program-window. At this line 
information of the WIBE state are indicated. 
The following information are contained in the status line (from the left to the right): 

● Information of data communication with progress bar,
● information of new NAVTEX messages,
● free,
● current time in UTC,
● status of the WIBE.

Export messages

For the import in other programms, weather, NAVTEX and fax messages of the WIBE can 
be exportet to any arbitrary folder.

The export function is situated in the configuration dialog 
(broadcasting schedule, menu Settings->Configuration).
Please enable the checkbox and set the destination folder.
Now the messages of the WIBE are stored in this folder. New 
received messages will replace automatically older ones in the 
destination folder.

Functional overview

The following table presents an overview of the WIBE software functions:

Menu Option Icon Function

File->Open... Opens an already stored message.

File->Save... Stores a message.

File->Print... Prints a message.

File->Exit Terminates the program.

Settings->Expand tree Opens / unfolds the menu tree. 

Settings->Collapse tree Closes / folds the menu tree. 

Settings->Zoom in Increases the barograph view (only the time 
scale) or the fax image.

Settings->Zoom out Decreases the barograph view (only the time 
scale) or the fax image. 
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Menu Option Icon Function

Settings->Rotate Turns a fax image around 90° to the left.

Settings->Configuration...
Opens the configuration dialog for 
broadcasting schedule and barometer 
altitude.

Settings->Reception test... Opens the reception test.

Help->Manual Opens the User Manual. 

Help->System information... Shows system information of the software 
and the WIBE.

Operating instructions

Environment

Please use the equipment only in the interior and dry environment. Do not expose the 
equipment in use to temperatures higher than 60°C and lower than 0°C.

Internal clock

The WIBE is equipped with an internal clock (RTC) which is buffered with a 3V lithium 
battery. The lithium battery should be exchanged at the latest after five years to guarantee 
a proper function of the WIBE.

Hints to radio reception

Electromagnetic interferences can impair the receipt. This can occur due to e.g. computer, 
electronic navigation equipment, fluorescent lamps, inverters, battery chargers, 
generators, electric motors, high voltage transmission lines etc. Therefore the antenna of 
the WIBE should be positioned as far away as possible from this equipment. The receipt 
can be impaired also by atmospheric disturbances (e.g. Thunderstorms). 
Especially in the short wave band the reception quality strongly fluctuates. Hence you 
should activate the reception of the most important messages at several times a day in the 
broadcasting schedule.

15



Specifications

Receipt-frequencies 147,3 kHz, 490kHz, 518kHz, 3,8-14,5MHz 
PC-interface USB full speed, socked B 
Supply voltage 12V 
Current consumption Reception Mode Approx. 80 - 120mA without active antenna
Current consumption Power Save Mode Approx. 50 - 60mA
Antenna input 50 Ω, BNC
Supply voltage active antenna 12V, max. 20mA 
Battery for internal clock Type: CR2032
Resolution of air pressure sensor 0,1hPa 
Absolute measurement error of the air 
pressure sensor ±1,5hPa

Typical long-term stability of the air 
pressure sensor -1hPa / year

Air pressure measuring interval 60s
Maximum recording span air pressure 7 days
Operating temperature 0..60°C 

Supported operating systems Windows 2000, XP, Vista.
Screen resolution: Min. 1024x768 pixel.

Memory for messages

Flash-memory
250KB for barograph data
256KB for NAVTEX data
512KB for RTTY data
3MB for fax data

Dimensions (LxWxH) Approx. 102mm x 130mm x 48mm
Weight Approx. 160g, without cable
For inside use only.

Warranty

If the WIBE exhibits a defect due to production or material defects within 24 months 
starting from the purchase date, it is either repaired by us or exchanged free of charge 
against appropriate equipment. 
To wearing parts (e.g. housing, batteries, etc.) the warranty applies for six months starting 
from purchase date. 
The warranty does not apply, if the defect is caused on inappropriate treatment or 
neglection of the manuals. 
A receipt of the warranty voucher with purchase date is required.
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Devices with a crossed out dustbin label have to disposed in the European Union via a separate 
garbage collection at a suitable collective places for the recycling of electric and electronic devices.

MÖRER SCHIFFSELEKTRONIK does not take responsibility for injuries or damages, which develop during 
or in consequence of the installation of this product. Each article of equipment can fail by various different 
reasons. Never use this equipment as the only information source, if by the loss of the equipment a danger 
exists for lives, health or material possession. Remember: This equipment is only assistance for the weather- 
and message information, and is no replacement for good sailor shank. The use of the equipment is on your 
own risk. Use it carefully and test its operability occasionally on the basis of other data from time to time.
No part of this publication may be reproduced, copied, stored in a retrieval system or transmitted in 
any form, electronic or otherwise without prior written permission from Mörer Schiffselektronik.
Mörer Schiffselektronik hereby grants the right to load an individual copy of this manual on non removable 
disk or another electronic storage medium for looking at it on a computer and to print out a copy of this 
manual, if this electronic or printed copy contains the complete text of this copyright explanation and a further 
unauthorized commercial spreading of this manual strictly one forbids. All rights reserved. 
The information contained herein can be changed at any time without previous proclamation. Mörer 
Schiffselektronik reserves itself the right to change or improve the products without notification.
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